ONE45 — CALCULATING FACULTY RESPONSE TIMES/FORM STATUS

Departments may want to know how many forms a faculty has let expire or have left outstanding, especially compared to
other faculty in the department. With CBME, departments may also want to know how quickly faculty are completing their
forms. While one45 made improvements to form data to help in this regard, for large numbers of forms, there is an issue
with access. For now, make use of Custom Search to get the information you need.

PART A walks you through collecting and preparing your data. (p. 1)
PART B contains steps to figure out how many completed, outstanding (saved/blank), or closed (expired) forms your faculty have (p. 6)
PART C helps you calculate the average time between when your faculty receive their forms and when they complete them (p. 7)

A. PREPARE YOUR DATA

1. Navigate to https://one45.med.dal.ca in your browser and log in.

2. In your program space, click the Sendouts tab.
Schedules SendoutN Forms @ Setup | {J Support

3. Click Custom Search from the side menu.
¥ Individual Sendouts
Bulk/Single Send
¥ Evaluation Tracking
Qutstanding Form
Completed Fo|

Custom Search

4. For the evaluator role, select Attending. Leave the other dropdowns as is.

Find forms with the following criteria:

® all or..
all or attending p
® all or.. |Rotations v

® all or.. |Form

5. Set your date ranges for your desired timeframe, likely academic year.
Date options:

Rotation dates v

From: Jul 1, 2018 To: Jun 30,2019 [,

exact match \ \

6. Check all the boxes except “deleted.”
Note: If you use head evaluator/releasor forms, you may want to check “deleted.” For those that don’t use head or
releasor forms, deleted would only be forms that you as PA deleted and would not be relevant. However, if you
use head or releasor forms, you may wish to include it. Ex. If a faculty member does not complete a contributing
form and the head evaluator submits the head form using the available completed contributing forms, it DELETES
contributing forms that have not been submitted. Unfortunately, you won'’t be able to tell the difference between
forms you deleted and forms a head evaluator deleted by submitting their form, but it may give you a sense of

completion.
Form status: Include:
# completed | bulk/single send

L

not ut distributed ¥ block sendout

* not 2 i
For evaluations sent out relating to:

¥ rotations

¥ saved

¥ closed -
academic sessions

deleted of— i
= | proposals

Aedae sncialte b
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7. Leave the default ordering selections and click Export to Excel.
Order results by:
1. Evaluator Name v
2. Date v

Search For Forms  Export to excel (CSV for larger results)

8. Find and open the Excel document you downloaded. Excel will likely request that you Enable Editing before you
make changes. Do so.
File Home Insert Page Layout Formulas Data Review View Help S Tell me what you want to do
J/ PROTECTED VIEW Be careful—files from the Internet can contain viruses. Unless you need to edit, it's safer to stay in Protected Vi“ Enable Editing
P2 > f
9.

The dates in the Excel spreadsheet might look like numbers, but Excel thinks they are actually text. We need

them to be viewed as dates to do our calculations. Unfortunately, using “Format Cells” option and specifying dates
doesn’t work to convert them. Follow these steps to have Excel recognize them as dates:

a. Highlight your date columns (E-G herre)rby clicking and holding E while dragging across to G.

L} < o

Cvalustor Target  Form

v Single  Mead
same  name  name  |wpan received completed Seed form
Asrdvark, DENCH,  Evaluatio [2015-08- 201811 20081119 Complet No No
Mary the JUDIthe nof 2208 19 -
Student  unithead Faculty 0938
oy
Rewudent
2016
Aprdvars, Windsor  Evaluateo (01808 201813 20081019  [Complet No No
Mary the the nof 222018 19 Je.:
Student Program Faculty .38
Dwector, by
Barbara  Resident

b. Press CTRL and F on your keyboard. The find window will appear. Click the Replace tab.

Find Replace _

Find what:

Options > >

Find All Find Mext Close

c. Inthe Find what window, enter 20.
In the Replace with window, enter 20.
Click Replace All.

Find Replace

Findwhat: |20 ’ v
Replace with: Zd

v

Replace All Replace Find All Find Next Close
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d. Excel will tell you the replacements were made.

o All done. We made 725 replacements.

[Cox |

e. The fields will appear to convert to number signs (with exceptions for cells that have a date span). This is

just Excel’s way of saying the cell is too small to display the date.

Moment Evaluator Target  Form Date Date Date Status  Single  Head Release
name name name name span received complete Send form form
| d
CVICU Aardvark, CVICU Evaluatio 2018-07- #######s s###8482 Complet No No No
Mary the nof 25-2018- d
Student Service 08-21
by
Resident
Neoplas Aardvark, DENCH, Seminar/ ###t#ns sungusss Closed No No No
ms: Mary the JUDIthe Presente
Academi Student unithead r
c Half Evaluatio
Day n
|Seminar

f. Widen the cells by clicking the line between the column headers so you can see the dates.

Dute spu

- L] < o )
Moment Dvaleator Target  Form e sl e
Rl e Ao e S fon
CViky Awrdvary, (VU Evalate ~So N

Mary the L
Soa0ent Service
oy
|} Resitent
Neoplas  Awovare, DENCW. Semnae/| 20181001 20151319 josed  No No Ne
- Mary the UDIthe Presente
Acadeny Stadent  unit head ¢
¢ Malt Evaluatio
Doy L
Hseminar
Umargen Awdvans, Asrdvars, G 080019 0181204 Ovtstand N ~o ~
¢y Mary the Mary the PROCEOUI 2008 1038 % |
Sudent Student( RLFORM
self) (LOG
)
Emergen AwOvark, Asrdvark, GM 20180000 20181318 Outstand No NO Ne
37 Mary the Mary e PROCIDUIISOR N ~

10. Now that you have made sure your dates are recognized as dates, click the first column to the right of the dates.

Then click Insert on the Home menu.

Home roent Page Layout  Formule Dita Review  View  Help D Tel me wha
A Cwt
) Cop

v By _- &2 ot Ddlete Four 33 Ewvey

Format P peter

ent fvahuator Target
L3 e Narme

[ Aardvark, CVICU Cvaluatio 2018-07-23

Mary the not 2018-08-21
Sudent Service
oy
Reucent
Was Aardvark, DENCH, Seminae/ 20181001 20181119 Cosed  [No No

Mary the JUDIthe Presente
o Student unithead r
fvaluatio

o0 Aardvark, Awdvars, GIM 018019 2018 1204 Outstand o No
Mary the Mary the PROCIDU 2008-10-38 g
Student  Student| REFORM
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11. A new column will appear. Click Number in the dropdown in the Home tab to specify this as a number column.

’ Formula Data Revew View Helg 4 L

A" A R & Sl et =
= (=] =
S oA $-%9 ¢ Deldete Format —
& k ’ =
ont . Number . e
E F 9 W I
Date span  Date Date Status Siny
received completed Ser
tio 2018-08-22 2018-11-15  2018-11-19 Complet No
2018-05-18 ed
¥
nt
tio 2018.08-22 2018-08-25 2018-10-1S Comolet No
12. Name the column Days to Completion.
Datespan Date Date Days to Status
received completed Completion
> 2018-08-22- 2018-11-15 2018-11-19 Complet
2018-09-18 ed

13. In the cell just below it, type an = sign.

8 F G H |

pan Date Date Days to Status S
received completed Completion S

18-22-  2018-11-15 2018-11-19 = Complet N

19-18 ed

14. Then click on the Date completed cell to its left. It will automatically enter the cell’s letter and number into your

formula.
=G2
D B F G H
n Date span  Date Date Days to St

e received  completed Completion
luatio 2018-08-22- 2018-11-15 2018-11-1 C

’ 2018-09-18 e
lty /

ident

2

li.maio AAan An AA AA1A AR AF Anan an ar ~

15. Now enter a minus sign.

Date Days to Statu
completed Completion
i 2018-11-19 =G2- Com

\ed
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16. Click on the cell under Date received to the left. It will automatically enter that cell’s letter and number as well.

=G2-F2
D E F G H
rm Datespan  Date Date Days to Stat
ime Jreceived _ completed Completion
aluatio 2018-08-22 - : 2018-11-15: 2018-11-19FG2-F2 Con
of 2018-09-18 | ! ed
1 1
culty i i
1 1
' 1 1
1
ssident / i
16 ; !
aluatio 2018-08-22 - 2018-08-25- 2018-10-15 Con

17. Hit Return on your keyboard. Your formula will now calculate the difference between the date the form was

completed by the preceptor and the date the form was received by them.

F G H |
Date Date Days to Status  Sing
received completed Completion Sen
2018-11-15 2018-11-19 4.00 Complet No
d

2018-08-25 2018-10-15 Complet No

18. Copy this formula to the rest of the cells by clicking the cell with the formula in it and double-clicking the little
square in the bottom right corner of the cell.

ite Date Days to Status Single
ceived completed Completion Send
2018-11-15 2018-11-19 4.00(Complet No
ed
¢ |
2018-08-25 2018-10-15 Complet No
ed

19. It will copy the formula down through the column. Don’t worry if the numbers look a little funny for the forms that
are not yet completed. We won’t be using those numbers anyway.

Date span  Date Date Days to Status Single Head R
received completed Completion Send form fc
2018-08-22- 2018-11-15 2018-11-19 4.00|/Complet No No N
2018-09-18 ed
2018-08-22-  2018-08-25 2018-10-1 51.00|Complet No No N
2018-09-18 ed
o

20. Now we can move on to generating the reports.
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PART B. STATUS OF ONE’S FORMS
This report will provide you with a count of the various form statuses a faculty member has within your specified date
span. The statuses can include:

CLOSED: The faculty member never completed this form and it expired.

COMPLETED: The faculty member completed the form.

SAVED, NOT COMPLETED: The faculty member has started but did not complete the form
OUTSTANDING: The faculty member has not completed nor started this form yet.

1. Click on one of the entries on your sheet then press CTRL and A on your keyboard to select all your data.

A B C D E F G H ! J K L
Moment Evaluator Target  Form  Datespan Date Date Daysto  Status Sindde Head Release
i |[name  name name  name received  completed Completion send form  form
Emergen Worksho Worksho GIM 2019-02-12 2019-02-12 -43508.00 Outstand Yes No No
% P o PROCEDU ing

Resident Resident REFORM
_Watts _Watts(s (LOG)

2| elf)
KWO01  WORKSH Watts, KW- 2018-11-05  2018-11-05 -43409.00 Outstand Yes No No
Transitio OP_DR, Resident Procedur ing
nto KARENW _Karen elog
Disciplin  ATTS1
e
23(Radonc)
01- WORKSH MacDona SAMPLE = 2018-07-04 2018-11-05 ~43409.00 Outstand Yes No No
Transitio OP_DR, Id, Barry FORM: ing
nto KEVINFR the Oto-

Disciplin ENCH4  Resident HNS1TTD,
e 1
(Otolaryn Assessin
24|gology) g patient
Anesthes WORKSH WORKSH GIM 2018-07-05 2018-07-05 2018-07-05 0.00 Deleted  Yes No No
ia OP_RES, OP_RES, PROCEDU:
RESIDENT RESIDENT RE FORM
22_Britta 22_Britta (LOG)
nyF nyF(self)

2. Click the Insert tab on zour Excel menu.

File Home Insert W Formulas Data Review View Help

3. Click Pivot Table.

File Home Insert Page Layout Formulas Data Review Wiew Hel
ES @ |;.| Fg Online Pictures 9 3D Models ~ HEGEtAdd-ins
'—E)Shapa g T2 SmartArt
PivotTable Reco d Table Pictures ) My Addei :
PivatTab ('5 lcons @ Screenshot - Q- My RS
Tables lllustrations Add-ins
J1 hd fx Single Send
A B C D E F G H

4. On the menu that appears, click OK.

Choase the data that you want to analyze
(®) Select a table or range

Y

1 Table/Range: Worksheet!SAST:SLSEP_El

CJ Use an external data source

Choose Connectian...
Connection name:
Use this workbook's Data Maodel
Choose where you want the PivotTable report to be placed
@ MNew Worksheet
O Existing Worksheet

R

3 Location:

I+

| Choose whether you want to analyze multiple t&8les

|:| Add this data to the Data Model
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5. A new tab will open on your worksheet with an empty pivot table.

@ B - | B I:B' [‘l Iz 7 B | B
PivotTable | Active | Group | Filter | Refresh Change Data | Actions | Calculations | Tools | Show
% Field~ | = . s - : S i
Data ~
A3 - fe v
A B C D BN~ . X
1] PivotTable Fields 22
2|
: Choose fields to add to report: G-
> | PTvotTabla Search 0
E 0iTabie2 |
® | Tobuildareport, choose | ] Moment name =]
7| fieldsfrom the PivotTable | [ Bvslutor name
8 Field List | [] Target name
9 [ Form name
ate span
10 [ Date sp
ate receive
1 Co d
12| — [[] Date completed -
=
14 Drag fields between areas below:
15 —_— = d
16 T Filters I Columns
17
18
19 |
20 | = Rows % Values
Zl_'
22_

6. To start, click the Evaluator name box and click and drag the box that appears into the ROWS section (if it doesn’t
go autom_atically).

T Choose fields to add to report: o
Row |
[ 3 LabEIs..:__, [Search p
DENCH,
[ JUDI the ‘ [ Moment name &
unit head| Evaluator name
44 [C] Target name
NUNN, [ Form name
5 |Rob [] Date span
palmer, [[] Date received
- Patsy the | [[] Date completed -
il — 3 jan
6 |tutor
Reid, Drag fields between areas below:
7 _‘Sheila g
\Windsor Filters Columns
the
Program
i Director,
E =
9 8 |Barbara = Rows X Values
Frank, Evaluator name *
9 |Mary
|Weaver,

7. Then check off Status from the list and click and drag the box that appears over to the COLUMNS.
2 s

TeaTas i Choose fields to add to report: & -
3 |Labels |- g Search 0
Row |Closed Complet Deleted Not ‘
|Labels ed distriby E ;j:‘t‘e”;‘,;:';: [«
o = e [ Date received
= e - [] Date completed
[OENCH, ‘ ] Days to Completion
Juoi the “ e
unit head [ Single Send
i [ Head form hd
INUNN,
6 ;Rob Drag fields between areas below:
;::;Etr;]e T Filters Columns
7 |tutor . Status .
;Reid,
8 Sheila
lwindsor = Rows E Values
the Evaluator name T
| Program
| Director,
ey B = Defer Lavout Undate
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8. Now check off Moment name and drag it to the VALUES section.

Fivotlable rields TO

2

T Choose fields to add to repart: b

|countof |Column = 2

;Moment |Labels Sanrih s
3 name = :

|Row |Closed Complet Deleted Not Outstand Saved, |Grand Moment nam [

|Labels ed distribut ing not Total Evaluator mm‘;\

ed complet | [] Target name

4 - ed [ Form name

|DENCH, 1 17 1 3 [ 22 L Date span

| JUDI the [ Date received

|unit head E gatefampleted o=
5 {

iNUNN, 1 1 Drag fields between areas below:
6 |Rob

|palmer 1 g 10 T Filters Il Columns

| .

|Patsy the Status Ed
7 [tutor ‘

|Reid, 1 1
8 [Sheila Rows ¥ Values

:Windsor 13 2 1 16 Evaluator name b Count of Moment na.. =

ithe

Program

Form_Data_Export

File Home Insert Page Layout Formulas Data Review View Help Analyze

Row Headers  [] Banded Rows

Subtotals Grand Report  Blank

Column Headers [] Banded Columns

¥ Totals~ | Layout~ Rows~
Layout PivotTable Style Options
D4 *: I Not distributed
e e e e i S S i e
1 {
2

|Countof Column

|Moment Labels

!name bt

W

|Row
4 ?Lahels ~ Closed Completed Not distributed Outstanding Saved, not completed Grand Total
|DENCH, 1 17 3 21 &
|1uDi the
|unit head

|Palmer, 1 9 10
;Patsythe
|tutor

o

10. You will now have a list of your faculty and the status of the forms they received. Large numbers of Closed
indicate areas of concern as it means the forms expired and were never completed. Outstanding forms COULD
b? well-overdue forms, but they can also be forms they only just received the day before.

ECount of Moment name Column

| Labels |+

iRow Labels - |Closed Completed Not distributed Outstanding Saved, not completed Grand Total

|DENCH, JuDi the unit head 1 17 3 21

EPaImer, Patsy the tutor 1 9 10

|Windsor the Program Director, 13 1 14

iBarbara

|Frank, Mary 2 11 4 1 18

| Weaver, Siquorney 2 1 3
) |Ballantine, R. Latasha 1 16 1 18
L EFuentes, Lorena 16 9 25
_ZEKaur, R. Nirupa 8 8 16
3 |MacDonald, Barry 3 18 5 d— 26
1 \Watte Marv Karan 1 1

11. Now you can proceed to report on the faculty’s average time to complete a form.
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PART C. TIME TO COMPLETION REPORT

You could modify the pivot table in PART B to get a summary of data on how quickly faculty complete their forms BUT

the steps below create a separate pivot table (in case you didn’t need to do PART B).

1. Find the worksheet that has your form data in it that you prepared in STEP A. Click on one of the entries on your

sheet then press CTRL and A on your keyboard to select all your data.

[Moment Evaluator Torget Form  Datespan _ bate Date Daysto  Stus sl Head Release
¢ |name  name  nmame  name received  completed  Completion Send form form
Emergen Worksho Worksho GM. 20150212 2019.02.12 430800 Outstand Yes  No  No

o b n PROCEDY ing

KWOL  WORKSH Watts, KW- 20151105 20181105 om0 Oustand Yes N No
[Transitio OP_DR, ~ Resident Procadur ing
etog

nto
pisciplin ATTS1

23]{gadonc)
01 WORKSH MacDona SAMPLE | 2018.07.04 20181105 0300 Outstand Yes No  No
[Transitio OP_OR, _ id,Barry. FORM: i

o

isciplin ENCHa  Resident HNS1TTD.
e by

(ototaryn Assessin
4l gology) gpatient
[Anesthes WORKSH WORKSH GIM  2018:07.05. 20180705 2018.07.05 0%0Delted Yes N0 Mo
o opRes, opes, pROCEDU
RESIDENT RESIDENT AE FORM
2 aitta 22 Brita (L0G)
ovFoyrelt)

2. Click the Insert tab on your Excel menu.

File Home Insert W Formulas Data Review View Help

3. Click Pivot Table.

File Home Insert Page Layout Formulas Data Review View Hel

o= B= - & Online Pict 3D Models ~
) B | i B Qs - | gy,
; : ré Shapes - T SmartArt
PivotTable Recol d Table Pictures iy I My Add 3
PivotTal % lcons fm} Sereenshot = | O~ My Add-ins
Tables lllustrations Add-ins
1 T fe Single Send
A B C D E F G H

4. On the menu that appears, click OK.

Choose the data that you want to analyze
| {®) Select a table or range

S

Table/Range: |Worksheet!SAST:515225

. (O Use an extemnal data source
1 Choose Cannettion...

Connection name:

Use

b tkbook's Data Model

| Chaose where you want the PivotTable report to be placed
(®) Hew Worksheet
() Existing Worksheet

Fi Location:

>

. Choose whether you want to analyze multiple t@8les
D Add this data to the Data Model

5. A new tab will open on your worksheet with an empty pivot table.
=] B ||| P [‘ﬁ B i} Bk B

vt | T | Cha| R | B Chacoe | e | | o |
el R e

Data hS

A3 % v
A B c D El.

1 PivotTable Fields R

; (Choose felds to add toceport &~

B | | ke

;- [ |

6 | Tobuild areport, choose O m -]

7 | fields from the PivotTable I I3 &

s Field List ar.

B O

4

U oo Bk

Bl _— oo pleted

13 a

1 2 Drag fields between areas below:

15 [

& Fittrs Columns
7

18

19

20 Row lues
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6. To start, click the Evaluator name box and click and drag the box that appears into the ROWS section (if it doesn’t
go automatically).

Choose fields to add to report: o v
Row
[ 3 |Labels -] | [Search jo
DENCH,
0 |uoithe 1 Moment name a
unithead| Evaluator name
44 | [ Target name
|NUNN, [ Form name
5 |Rob [ Date span
|Palmer, | [ Date received
1 Patsy the | [] Date completed -
6 |tutor
Reid, | Diag fields between areas below:
7 |Sheila =
|\Windsar T Filters Il Celumns
the
Program
o Director,
4 8 |Barbara = Rows E Values
Frank, | Evaluator name -
9 |Mary
Weaver,

7. Check Status and drag the box that appears into the FILTERS section.

Search

[ Date received

[] Date completed

[] Days to Completion
Status

[] Single Send

[] Head farm

[1 Release form

Drag fields between areas bel

T Filters 1l Columns

Status b

8. In the dropdown that appears above your pivot table, click the STATUS dropdown and select Completed. Click
OK. We neeg to do this as we are IookinLg at the average completion time so we need to exclude everything else.

[status PivotTable F
- Completed T, )
| - " 1 Choose fields to add
| |Search /O |
| IRow Labels (A 11 Search
¢ [DENCH, JUL ... Closed |
f _!Palmer, Pal . Complete . e | [] Date received
|Windsorth - Mot distribited [] Date completed

9. Check Days to Completion and ensure it is in the VALUES section.
A B ) c

D [«
1 |Status Completed Bl PivotTable Fields M %
2

1 = Choose fields to add to report: ap -
3 |Row Labels ~ | Sum of Days to Completion |
4 ;DENCH, JUDI the unit head 131 } Susich o
5 |Palmer, Patsy the tutor 2 :

| Windsor the Program Director, 3 [] Date received =

6 |Barbara [ Date completed
7 iFrank, Mary | Days to Completion

2 iWeaver,Siquorney Status \ bTa|
9 EBallantine, R. Latasha [ Single Send

10 |Fuentes, Lorena [ Head form
11 ;Kaur, R. Nirupa [ Release form
12 :MacDonaId, Barry

13 Watts, Mary, Karen

14 EMacDonaId, Mary Chantelle

Drag fields between areas below:

scoccococococoonmo oo B

15 |MacDonald, Mary Jessica L HiShelanns

16 | MacDonald, Mary JoAnn Status =

17 EMacDonsld, Mary Katie

18 |MacDonald, Mary Kevin0113

19 |MacDonald, Mary Kevin0212 = Rows Z Values

20 iP\.I'IE(:DCH'IEM,. Mary Keving Evaluator name = Sum of Days to Compl... ™

2T iMacDanald. Marv KevinNovs
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10. The default is to SUM or COUNT the Days to Completion (see below) but that’s not what we want.

1 Nate romnletad
Drag fields between areas below:

T Filters Il Columns

Status :

= Rows £ Values

Evaluator name unt of Moment na... ~

11. On the Days to Completion box, click the arrow to access a menu.

LTdy 1TEIUs DELWERTT di Eds LIEIWG

T Filters Il Columns
Status ¥
Rows E Values
Evaluator name - Sum of Days to Compl.. ™

12. Select Value Field Settings from the menu that appeaf.
I

_ Il Moveto Row Labels =
I Filters 2 Di

= Moveto Column Labels

Status b
Re
. R ve Field

_)'R emove Fie Gl

= Rows |[§ ValueField S :
oW .'ﬂ a.ue iel E? <

Evaluator name x ‘Sumnﬂlé}‘stb ko7 >
3

13. In the menu thq’g_q&glears, chan_ge it to A\{ERAGE and_click OK.

Source Mame: Moment name

Custom Mame: |Average of Moment name

summarize Values By  Show Values As

Summarize value field by
Choose the type of calculation that you want to use to summarize
data from the selected field

Sum ~
Count

Max
Min
Product

| Mumber Format Cancel
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14. You will now have the average number of days it takes for each of your faculty to complete their forms.
A i £

Status

Row Labels

DEMCH, JUDI the unit head

Palmer, Patsy the tutor

Windsor the Program Director, Barbara
Frank, Mary

Completed

T

~ Average of Days to Completion

e

7.705882353
0.222222222
0.230769231
6.181818182

Weaver, Siguorney

Dallantimn O §atacha

1
7
3
4
5
6
7
8
a

15. If you wish to limit the decimal points, first highlight the column with the averages in it.

A
Status

Row Labels

DENCH, JUDI the unit head

Palmer, Patsy the tutor

Windsor the Program Director, Barbara
Frank, Mary

Weaver, Siquorney

Ballantine, R. Latasha

16.

- |Status

i |Row Labels

DENCH, JUDI the unit head

Palmer, Patsy the tutor

Windsor the Program Director, Barbara
Frank, Mary

i |Weaver, Siguorney

Ballantine, R. Latasha

Fuentes, Lorena

—

o

Kaur, R. Nirupa

17. Select Number from the next menu that appears and set it to 2 decimal points (or your desired number).

B

o

n

:

Completed -7

Average of Days to Completion

7.705882353
0.222222277
0.230769231
6.181818182

&

&
Average of Daysto! '

Completed

Fill

=~

Protection

Number  Alignment Font Border

LCategory:

General Sample
Completed

Currency s

Accounting £ 1

Bite Decimal places: |2

Time [[] Use 1000 Separatar ()

Percentage

Fraction tive numbers:

Scientific

Text

Special

Custom

18. Cpslick OK when done.

Custom

a4

Number i used
formatting for monetary

for general display of numbers. Currency and Accounting offer speci
value.

falized

Cancel

0
0

Right-click over column B and select Format Cells from the menu that appears.

Cut
Copy
Paste Options:

.r_-.l:.l

Paste Special...
Insert
Delete
Clear Contents

Format Cel[;..]}

19. Your averages will now be limited to two decimal points.

|Row Labels

|DENCH, JUDI the unit head

;Palmer, Patsy the tutor

fWindsorthe Program Director, Barbara
_gFranlncr Mary

:Weauer, Siguorney

3
4
5
6
7
3
9 |Ballantine. R. Latasha

| v Average of Days to Completion

e

7.71
0.22
0.23
6.18
0.00
0.00
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